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Introduction 
The Patient Assessment Documentation Package (PADP) Version 1.0 is a Veterans Health Information 
Systems and Technology Architecture (VistA) software application that enables Registered Nurses (RNs) 
to document, in a standardized format, patient care during an inpatient stay. Although the content is 
standardized for use across the VA system, some parameters can be set to support the unique processes at 
individual medical centers.  
 
PADP interfaces directly with several VistA applications, including Computerized Patient Record System 
(CPRS), Clinical Reminders, Consult Tracking, Allergy/Adverse Reaction Tracking, Mental Health 
Assistant, Vitals, and Patient Care Encounter (PCE).  
 
PADP is a Delphi application, which supports RNs in documenting patient care during an inpatient stay. 
It includes the following templates:   
• Admission – RN Assessment allows RNs to document the status of the patient at admission. 
• Admission – Nursing Data Collection allows Licensed Practical Nurses (LPNs) and other nursing 

staff, including the RN, to enter basic patient data, such as vitals and belongings at the time of 
admission. 

• RN Reassessment allows RNs to document the condition of the patient on a regular basis and any 
time during the inpatient stay.  

• Interdisciplinary Plan of Care interfaces with admission and reassessment data, and allows additional 
information to be entered by the RN and other health care personnel (physicians, social workers, 
chaplain, etc.). All clinical staff can enter information into the Plan of Care. The Plan of Care can be 
printed and given to the patient when appropriate. 

 
PADP consists of a KIDS build, NUPA 1.0, and four (4) Delphi GUI templates in three executables.  
1. The executable, Admassess.exe, contains the Admission - RN Assessment template and the 

Admission - Nursing Data Collection template. 
2. The executable, Admassess_Shift.exe, contains the RN Reassessment template. 
3. The executable, Admassess_Careplan.exe, contains the Interdisciplinary Plan of Care template. 
 
Each template is associated with a note.  
• The Admission - RN Assessment template is associated with the note: RN Admission Assessment  
• The Admission - Nursing Data Collection template is associated with the note: Nursing Admission 

Data Collection 
• The RN Reassessment template  is associated with the note: RN Reassessment 
• The Interdisciplinary Plan of Care template is associated with the note: Interdisciplinary Plan of 

Care 
 
PADP adds to VistA, a new namespace (NUPA), four (4) Progress Notes, five (5) printouts, fourteen (14) 
files, thirty-six (36) parameters, and new health factors. The 5 printouts are: 
1. The Daily Plan® is a health summary designed to be given to the patient and family 
2. Plan of Care is a plan designed to guide the nursing staff 
3. Discharge Plan is for discharge planners 
4. Belongings is a list of patient belongings 
5. Safe Patient Handling is designed to guide the transfer of a patient 
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Using the RN Reassessment 
Registered Nurses (RNs) use the RN Reassessment template to document inpatient care in a standardized 
format at regular times and as needed. With the reassessment template, you collect information associated 
with new problems and with required physical assessment documentation, such as skin condition, 
respiratory, genitourinary, and gastrointestinal status.  

Opening RN Reassessment 
You access the RN Reassessment through CPRS from the Tools menu. 
1. Open CPRS. 
2. Select a patient. 
3. Click Tools. 
4. Select RN Reassessment. 

Enter a patient window automatically opens to the CPRS patient. 

Note: You may have to re-enter your CPRS access and verify codes, depending on local 
site setup. 

 

Access through CPRS 
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No Previously Saved Information 

The Enter a patient window displays. 

 

RN Reassessment, Enter  a patient window with no previously saved information 

1. Select an Assessment Type. 
2. Click Start Note. 

The reassessment template opens to the General Information tab for the CPRS patient. 

Previously Entered Information Available for One Patient 

 

Patient selection window with previously entered information available for  one patient 
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Restore Patient’s Data/No 

If you previously entered data on one patient, you are prompted with: You have previously saved data on 
a note for patient <PADPPATIENT,ONE > 
1. Select an Assessment Type. 
2. Select No. 

The patient’s information is deleted, but the Internal Entry Number (IEN) for the patient displays in 
the Enter a patient text box. 

3. Click Start Note. 
The template opens to the General Information tab and you can enter new data for that CPRS patient. 

4. Optional: You can delete the IEN of that CPRS patient, enter the name of a different patient, and 
click Start Note. 

Note: The Internal Entry Number (IEN) is a unique, computer-generated number that 
identifies a specific patient in your system. The IEN has no impact on the 
completed assessment, nor does it display again. 

Restore Patient’s Data/Yes 

If you previously entered data on one patient, you are prompted with: You have previously saved data on 
a note for patient <PADPPATIENT,ONE > m 
1. Select an Assessment Type. 
2. Select Yes. 
3. Click Start Note. 

The template opens General Information tab for the CPRS patient with the data restored. 

Note: PADP does a search for previously entered assessments/reassessments within the 
last 12 hours. 

Previously Entered Information Available for Two or More Patients 

If you have previously stored data from more than one patient, you are asked if you want to view a list of 
those patients. 

 

Patient selection window with previously entered information available for  more than one patient 
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View the Patients?/No 

If you say No, the patient’s name displays in the Enter a patient text box as a number that identifies the 
CPRS patient. 
1. Select Assessment Type. 
2. Click Start Note.  
3. The template opens to the General Information tab. 

View the Patients?/Yes 

1. Select Yes. 
2. Select an Assessment Type. 

Patient Selection window displays with a list of patients with saved data. 

 

Patient SelectionList 

Patient on the List 

1. Select a name. 
2. Click OK.  

The template opens to the General Information tab. 
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Patient not on the List 

1. Click Cancel. 
The number that represents your CPRS patient is in the Enter a patient text box.  

2. Click the Start Note.  
The template opens to the General Information tab. 

 

RN Reassessment, General Information (Gen Inf) tab window, Gen I Page 1 
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Patient not yet Assigned to an Inpatient Bed 

When a patient is not assigned an inpatient bed, a location  automatically displays over the General 
Information window. 

 

Location : Select visit location  

1. Select a current patient location, i.e., outpatient clinic. 
Navigate quickly to the current location by entering the first letter of the location. 

2. Click OK. 

Saving and Uploading Data 

Auto Save 

Data are saved automatically. Frequency of auto-save is set locally.  

 

Saving data: percentage saved indicator  
(bottom r ight corner  of the window) 
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Manual Save 

You can save data by using the File menu on any tab. 

 

RN Reassessment window, File menu 

Upload Data 

To create a note you must upload the data into VistA and CPRS:  
1. Open the File menu on any tab and select Upload Data. 

Results from your upload display, verifying that the data is uploaded. 

 

RN Reassessment, Upload results window 

Note: The unsigned note, selected consults, and PCE data/Health Factors are uploaded 
into CPRS and VistA. 

2. If the information is incomplete, an Error Listing window displays indicating the pages within 
specific tabs that require attention.  
• The tabs with pages that require attention are blue. 
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RN Reassessment, Er ror  Listing window 

• Once the pages are completed, the tab returns to gray. 
i. Double-click an item to go to the page that requires attention. 
ii. When all the errors are completed, select Upload Data again. 

Save and Exit 

To save data and temporarily leave the template: 
1. Open the File menu on any tab. 
2. Select Save and Exit. 
3. When you reopen the template, your previously entered data is there. 

Save Now 

To save data, but not close the template and continue to enter data: 
1. Open the File menu on any tab. 
2. Select Save Now. 
3. Continue to enter data for the current patient. 
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Exit  

1. From any tab, click X in the top right corner of the window. 
Warning message displays. 

 

Warning : Do you really wish to exit? 

2. Click Yes. 
or 
1. From any tab, open the File menu and click Exit. 

Warning message displays. 
2. Click Yes. 
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Signing Notes 

Go to CPRS to sign your uploaded, unsigned notes and consults. 
 
You can also sign unsigned notes after the upload from the View Text tab in the template. 
 
1. Click View Text. 

 

RN Reassessments, View Text tab after  upload 

2. Click Sign Note/Consult. 

 

RN Reassessment, Sign Note/Consult Button 

3. Enter your electronic signature and click Accept e-sig. 
4. To prevent the signing of an uploaded note, click Cancel e-sig. 

Note: If there is only a note to sign, the button is Note. 
If there is a consult(s) to sign, the button is Sign Note/Consult. 
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Working in a Care Plan 
The Care Plan page for each section of the RN Reassessment works the same way. The steps apply to 
each of the care plan (CP) pages. 

 

RN Reassessment, <Education> - Problems/Interventions/Desired Outcomes,  
<Educ> CP window 
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Care Plan Table 

 

RN Reassessment, Problems/Interventions/Desired Outcomes table 

The width of each Care Plan column is adjustable. There are ten columns in the Care Plan 
(Problems/Interventions/Desired Outcomes) table. 
 
Column Description 
Tab Tab in which the problem was identified in a previous assessment 

Example 
The problems came from the Mental Health Assessment, MH tab 

Problem Problem of concern from a previous assessment 
Date Identified Date the problem was identified 
Desired Outcome Preferred resolution of the problem 
Prob Eval 
(Problem Evaluation) 

In relation to the problem, how are things going? 
a. No change/Stable  
b. Deteriorating  
c. Improving  
d. Resolved 
e. Unresolved at discharge 

Prob Eval Date 
(Problem Evaluation Date) 

Date on which the problem was last evaluated 

Intervention The what to do for the patient you identify, so that the problem 
will improve/get better/not get worse 

Int Started  
(Intervention Started) 

Date on which the intervention was initiated 

Int Status  
(Intervention Status) 

In relation to the intervention, how should the staff proceed? 
a. Complete 
b. Continue 
c. Discontinue 
d. Pending (intervention was ordered but not started, such as 

a special bed or a lab test) 
e. Not on file (status not evaluated) 

Int Stat Date 
(Intervention Status Date) 

Date on which the status of the intervention was evaluated 

 
  



 

14 Patient Assessment (NUPA) V.1 April 2012 
 RN Reassessment User Manual 

Updating an Existing Problem/Intervention 

All care plans are updated the same way. If problems are entered during a previous assessment, the CP 
page from any tab is bold and italicized. 

 

RN Reassessment, <Resp> tab 

1. Click <Resp> CP. 
The <Respiratory> - Problems/Interventions/Desired Outcomes window displays. 

 

RN Reassessment, <Resp> CP window 

2. Click a problem.  
Problem evaluation, Intervention status, and Problem/intervention detail become available. 
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RN Reassessment, <Resp> CP window 
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3. Select a problem evaluation and an intervention status for the selected problem. 
Evaluate both the problem and the specific interventions each time you document. 

 

Problem evaluation, Intervention status, and Problem/Intervention detail 

4. Click OK. 
Information  displays. 

 

Information : Plan/intervention updated! 

5. Click OK to complete the problem/intervention. 
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6. Review the care plan table. 
The Prob Eval/Int Status are updated and the Prob Eval Date/Int Status Date are added. 

 

RN Reassessment, <Resp> CP window 
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7. Click View history for this problem to view the history of the selected problem. 
The Problem History displays. 

 

Problem History window 

8. Click Close. 
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Adding a New Intervention for an Existing Problem 

1. Click a problem. 
2. Click Add New Intervention to this problem. 

The Add New Problem/Intervention window displays with the area and problem selected. 

 

Add New Problem/Intervention window 

3. Select an intervention from the Select Interventions list box for the selected problem. 
4. Click Add.  

Information  displays. 

 

Information : New Intervention added! 

5. Click OK. 
6. Click Exit. 
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Adding a New Problem/Intervention 

 

RN Reassessment, <Resp> CP window 

1. Click Add New Problem. 
Add New Problem/Intervention window displays. 

 

Add New Problem/Intervention window 

Note: The Respiratory area is auto selected, because you are in the Resp CP. 

2. Select a problem from the Select Problem(s) list box. 
You can select only one problem at a time. 
The Desired Outcome text box and the Select Interventions list box display. 
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Add New Problem/Intervention window for  problem/intervention options 

3. Select an intervention from the Select Interventions list box. 
4. Click Add. 

Information  displays. 

 

Information : New Problem/Intervention added! 

5. Click OK. 
6. Click Exit. 
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Other Problems 

Some problems generate a  to enter problems that are not on the predefined list. 
1. Select an Other problem in the Select Problems list box. 

The Other problems  displays. 

 

Add New Problem/Intervention window with Other   

2. Type the other problem into the text box. 
3. Click OK. 
4. Type a desired outcome into the Desired Outcome text box. 
5. Select one or more interventions from the Select Interventions list box. 
6. Click Add. 

Information  displays. 

 

Information : New Problem/Intervention added! 

7. Click OK. 
8. Click Exit. 
9. To add more other problems, repeat steps 1-8, as necessary. 
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Other Interventions 

Some interventions generate a  to enter interventions that are not on the predefined list. 
1. Select an Other intervention in the Select Interventions list box. 

The Other intervention  displays. 
2. Type the other intervention into the text box.  
3. Click OK. 

 

Add New Problem/Intervention window with Other   

4. Click Add to transfer the intervention to the care plan.  
Information  displays. 

 

Information : New Problem/Intervention added! 

5. Click OK. 
6. Click Exit. 
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Working in the Consults 
All the consults in Reassessment work the same way. The following steps apply to each of the consults. 
When a consult is required, a mandatory consult message is highlighted in red. Ordering a Chaplain 
Consult is an example of how to work in any of the consults. 

Example – Ordering a Chaplain Consult 

Order a Chaplain Consult from Gen Inf tab, Gen I Page 2 in the Spiritual/Cultural Assessment section. 
 
The Chaplain Consult is mandatory when the patient answers Yes to any one of the following questions. 
• Are there religious practices or spiritual concerns the patient wants the chaplain, physician, and other 

health care team members to immediately know about? 
• Patient requests an immediate visit from the Chaplain? 
• Does patient have a pastor or clergy who should be notified of this hospitalization? 
 
1. Select Yes and a message indicating the consult is mandatory displays: 

Chaplain consult mandatory 

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 2 window  
Spir itual/Cultural Assessment 

2. Click <Chaplain Consult>. 
The <INPATIENT CHAPLAIN> Consult window displays. 

 

INPATIENT CHAPLAIN Consult window 



 

April 2012 Patient Assessment (NUPA) V.1 25 
 RN Reassessment User Manual  

a. Complete all fields with asterisks; they are required fields. 
b. Click Upload Consult. 

Information  displays indicating the consult is uploaded with the reassessment note. 

 

Information : Consult will be uploaded with the note. 

3. Click OK.  
On the Gen Inf tab, Gen I Page 2, under the Chaplain Consult button, Will Send displays. 

Note: Manage consults according to medical center policy. If nurses at your site do not 
order consults, upload a mandatory consult, but do not sign it.  
The identified provider will be notified that there is a consult to sign. 
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Working in the Template 
1. To complete the template, move through the fields from left to right and then down. 
2. The active page displays first and the page tab is white. 
3. Each tab across the bottom is subdivided into pages, which display on the right above the bar of tabs. 
4. Each field with an asterisk (*) must have an entry.  
5. A field without an asterisk is optional.  
6. You must enter optional information where appropriate for the patient. 

Moving through the Template with a Mouse 

There are two ways to move from tab to tab within the template.  
1. Click a tab at the bottom of any of the RN Reassessment windows. 

The selected tab opens. 

 

RN Reassessment tabs 

2. Open the Tabs menu and select a tab from the list. 
The selected tab opens. 

 

RN Reassessment window, Tabs menu 
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Moving through the Template without a Mouse 

Ctrl-Alt Keys 

You can move from tab to tab using Ctrl+Alt+<letter>. The list contains the keys to use for each of the 
tabs. 
 
Tab Keys 
General Information Ctrl +Alt+G 
Education Ctrl +Alt+E 
Pain Ctrl +Alt+P 
IV Ctrl +Alt+I 
Respiratory Ctrl +Alt+R 
Cardiovascular Ctrl +Alt+L 
Neurological Ctrl +Alt+N 
Gastrointestinal Ctrl +Alt+A 
Genitourinary Ctrl +Alt+T 
Musculoskeletal Ctrl +Alt+M 
Skin Ctrl +Alt+S 
Psychosocial Ctrl +Alt+Y 
Restraints Ctrl +Alt+Z 
Mental Health Ctrl +Alt+H 
Functional Ctrl +Alt+F 
Discharge Planning Ctrl +Alt+D 
PCE Ctrl +Alt+X 
View Text Ctrl +Alt+V 
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Go to Radiogroup 

The Go to radiogroup is designed to navigate the templates with keyboard commands, when the mouse 
stops working during a patient assessment. It also satisfies the 508-compliant requirement, under Section 
508 of the Rehabilitation Act, to be able to navigate the templates without using a mouse.  

 

Go button 

1. Use the Tab key to move to the bottom of the page. 
2. Use the arrow keys to move up/down in the Go to radiogroup: list. 
3. Click Go. 
or 
1. Click the drop-down arrow in the Go to radiogroup: drop-down list. 
2. Select a radiogroup. 
3. Click Go. 

Viewing Previously Entered Data 

Some of the information entered during the admission assessment or a reassessment is pulled forward to 
the current reassessment.  
• Prior responses to many questions are embedded as read-only in the template. The responses do not 

show up in the new Progress Note. 
• Although the prior response cannot be edited, in many places the information can be updated. 
 
For example, the Primary Language is identified as English and can be updated. 

 

Pr ior  patient response: English  
Pr imary language 

  



 

April 2012 Patient Assessment (NUPA) V.1 29 
 RN Reassessment User Manual  

For example, Advance Directive information was not requested in the previous assessment. Now the 
patient requests information on Advance Directives and a consult can be sent. 

 

Pr ior  response: No 
Does patient wish to indicate or  make changes to an Advance Directive 

• Some data entered on one page in the template also displays on another page. 
Information entered on the Psychosocial tab, P/S Page 3 displays on the Discharge Planning tab 
shaded in yellow. 

 

RN Reassessment, Discharge Planning (DP) tab, DP Page 1 window 
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Navigating the RN Reassessment Tabs 
The RN Reassessment template has 18 tabs. 

General Information (Gen Inf) 
The RN Reassessment template opens to the General Information (Gen Inf) tab, the first tab at the bottom 
on the left.  

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 1 window 

Gen I Page 1 contains information that is similar to its equivalent on the RN Assessment. It is previously 
entered information and is read-only. 
 
1. Click Gen I Page 2. 

Gen I Page 2 displays. 
2. Populate Gen I Page 2, if necessary. 
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RN Reassessment, General Information (Gen Inf) tab, Gen I Page 2 window 

Gen I Page 2 contains information that can be updated, as well as information that is read-only.  
• Allergies are added on Gen I Page 2, in the Allergies text box. 
• None of the fields on Gen I Page 2 is required during reassessment, provided a completed admission 

assessment is on file. 

Adding an Allergy 

Allergies/Adverse Reactions are uploaded immediately into the Allergy/Adverse Reaction Package when 
saved. 

Note: Follow your local medical center policy with regard to adding allergies. 

1. Click Add New Allergy.  
The Add New Allergies window displays. 
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Add New Allergies window 

2. Type 3-5 letters of the reported allergy, into the Search for text box. 
3. Click Search. 
4. Double-click an allergy in the Allergy list.  

The Sign/Symptoms list box displays. 

 

Add New Allergies window with Sign/Symptoms available 

5. In the Observed/Historical box, select Observed or Historical. 
6. In the Nature of reaction text box, select Allergy, Pharmacological, or Unknown. 
7. Select one or more reported signs/symptoms. 
8. Click OK and the allergy is saved in the Adverse Drug Reaction (ADR) file. 

Information  displays to confirm the allergy is saved. 
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Information : Allergy save done! 

9. Click OK. 
10. Click Close. 

Initiating a Social Work Consult for Advance Directives 

All of the consults in RN Reassessment work the same way; refer to the instructions in Working in the 
Consults on page 24. 
 
1. Click Gen I Page 3.  

Gen I Page 3 displays. 

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 3 window 
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2. Populate Gen I Page 3. 
3. Make appropriate selections in the Advance Directive section. 

If the patient wants to initiate or make changes to an Advance Directive, you are required to order a 
Social Work Consult. 

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 3 window, Social 
Work Consult Mandatory 

Note: You cannot upload a Progress Note, unless you order the Social Work consult. 
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Changing Emergency Contact Information 

1. Click Gen I Page 4. 
Gen I Page 4 displays with the Emergency contact information, Support person contact 
information, and General observations/comments text boxes available for additional information. 

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 4 window 
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Emergency Contact and Suppor t Person Information 

2. To update the emergency contact information, click Change Contact. 
The Emergency contact information section expands. 

3. Complete all the fields with asterisks; they are required fields. 
4. Click Save Contact. 
5. To cancel the update, click Cancel Contact before you click Save Contact. 
6. Document the name and contact information of the patient’s support person. 

It is required information. 
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Education (Educ) 
The Education Tab contains the educational assessment and a readiness to learn. The Educational 
Assessment is unavailable when the patient cannot respond. 
 
Educ Page 1 contains information that can be updated, but none of the fields on Educ Page 1 is required 
during reassessment.  

 

RN Reassessment, Educational Assessment (Educ) tab, Edu Page 1 window 

1. Click Educ. 
Educ Page 1 displays. 

2. Update Educ Page 1, if necessary. 
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3. Click Educ CP. 
Educ CP displays. 

 

RN Reassessment, Educational Assessment (Educ) tab, Educ CP window 

4. Update Educ CP. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Pain (Pain) 
The Pain tab in reassessment is similar to the tab in the Admission – RN Assessment.  
• If Is pain is a problem for patient was documented as Yes in the Admission - RN Assessment, it is 

pulled into the RN Reassessment.  
• If Is pain is a problem for patient was documented as No in the Admission - RN Assessment, the 

reassessment pages work like those in Admission – RN Assessment. If there is no pain at the time of 
the reassessment, all pain locations are unavailable. 

 

RN Reassessment, Pain Assessment (Pain) tab, Pain Page 1 window 

1. Click Pain. 
Pain Page 1 displays. 

2. Populate Pain Page 1. 
a. Select a radio button in the Is pain a problem for the patient group. The fields that display vary 

depending on the response for this query. 
• Yes 
• No 
• Unable to respond to questions 

b. Select a radio button in the Is patient on Palliative/Comfort Care group. 

Is pain a problem for the patient/Yes 

1. If a patient reports that pain is a problem (even if there is no pain currently), select Yes.  
a. The Other Pain and Other Pain 2 pages are available when the patient identifies multiple pain 

locations. There are five pain location sections.  
b. Identify Pain Location #1 and document the behavioral indicators. 
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c. Complete all fields with asterisks; they are required fields. 

 

RN Reassessment, Pain Assessment (Pain) tab, Pain Page 1 window 
Is Patient having any pain now with Yes selected 

2. When Pain Location #1 is complete and you have more pain locations to document, select the Other 
pain location ? check box. 
Other Pain page displays. 
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RN Reassessment, Pain Assessment (Pain) tab, Other  Pain window 
Pain Location #2 and Pain Location #3 

3. Optional: Populate the Other Pain page. 
a. Identify Pain Location #2/Pain Location #3 and document the behavioral indicators. 
b. Complete all fields with asterisks; they are required fields. 
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4. When Pain Locations #2 and #3 are complete and you have more pain locations to document, select 
the More pain locations? check box. 
Other Pain 2 displays. 

 

RN Reassessment, Pain Assessment (Pain) tab, Other  Pain 2 window 
Pain Location #4 and Pain Location #5 

5. Optional: Populate the Other Pain 2 page. 
a. Identify Pain Location #4/Pain Location #5 and document the behavioral indicators. 
b. Complete all fields with asterisks; they are required fields. 

6. If you require more than five pain locations, continue to document on the Pain Comm page in the 
General observations/comments text box. 
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Is pain a problem for the patient/No 

When No is selected on Pain Page 1, many fields are unavailable and no documentation is necessary. 

 

RN Reassessment, Pain Assessment (Pain) tab, Pain Page 1 window  
Is patient having any pain now/No 
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Is pain a problem for the patient/Unable to respond to questions 

 

RN Reassessment, Pain Assessment (Pain) tab, Pain Page 1 window  
Is patient having any pain now/Unable to respond to questions 

1. When Unable to respond to questions is selected on Pain Page 1 
a. Type an explanation for unable to respond in the Explain why patient unable to respond to 

questions text box. 
b. Select behavioral indicators in the Does patient exhibit behavioral indicators related to pain 

list box. 
c. Select a radio button in the Is patient on Palliative/Comfort Care group. 
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2. Click Pain Comm. 
Pain Comm displays. 

 

RN Reassessment, Pain Assessment (Pain) tab, Pain Comm window 

3. Populate Pain Comm, if necessary. 
Use the General observations/comments text box for additional information. 
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4. Click Pain CP. 
Pain CP displays. 

 

RN Reassessment, Pain – Problems/Interventions/Desired Outcomes, Pain CP window 

5. Populate Pain CP. 
Refer to the instructions in Working in a Care Plan on page 12. 
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IV (IV) 
On the IV tab, document new IV locations and Dialysis access, as well as update existing IV locations 
and Dialysis access. 

No IV/Vascular Access Devices 

1. Click IV. 
IV Periph displays. 

2. If a patient has no IVs or dialysis access in place, select the No IV/vascular access devices check box 
and none of the IV pages or Add New IV Location are available. 

3. Move to the next tab. 

 

RN Reassessment, IV (IV) tab, IV Per iph window 
No IV/vascular  access device selected 
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Peripheral Lines - IV Periph 

Existing IV Lines 

If IVs were present at time of the Admission – RN Assessment or in previous reassessments, those IVs 
display on the IV tab. 

 

RN Reassessment, IV (IV) tab, IV Per iph window 
with an existing IV line 

1. Populate IV Periph. 
2. Select an existing IV and the edit fields for the selected IV are made available. 

Complete all the fields with asterisks; they are required fields. 
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RN Reassessment, IV (IV) tab, IV Per iph window with existing IV line 

3. To cancel entered data before upload, click Cancel edit. 
4. To upload updated information, click OK. 
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New IV Lines 

 

RN Reassessment, IV (IV) tab, IV Per iph window 

5. Click Add New IV Location. 
The Location drop-down list box displays in the Edit Peripheral Line site #1 section. 

6. Select a location and additional fields become available. 
Complete all the fields with asterisks; they are required fields. 

7. To cancel entered data before upload, click Cancel edit. 
8. To upload updated information, click OK. 
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RN Reassessment, IV (IV) tab, IV Per iph window with a per ipheral line location 

9. To add another IV location, repeat steps 6 through 8.  

Note: There is no limit to the number of IV locations you can enter.  
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Central IV Lines – IV Central 

1. Click IV Central. 
IV Central displays. 

 

RN Reassessment, IV (IV) tab, IV Central window 

2. Populate IV Central. 
3. Click Add New CL Location. 

The Type drop-down text box displays in the Edit Central Line site #1 section. 
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RN Reassessment, IV (IV) tab, IV Central window 

4. Select a type and a location. 
Complete all the fields with asterisks; they are required fields. 

5. To cancel entered data before upload, click Cancel edit. 
6. To upload updated information, click OK. 
7. To add another central line, repeat steps 3 through 6.  
  



 

54 Patient Assessment (NUPA) V.1 April 2012 
 RN Reassessment User Manual 

Dialysis Ports - IV Dialysis 

1. Click IV Dialysis. 
IV Dialysis displays. 

 

RN Reassessment, IV (IV) tab, IV Dialysis window 

2. Populate IV Dialysis. 
3. Click Add New Dialysis Location. 

The Type and Select Dialysis location drop-down list boxes display in the Edit Dialysis access 
location #1 section. 

4. Select type and location. 
Complete all the fields with asterisks; they are required fields. 
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RN Reassessment, IV (IV) tab, IV Dialysis window 

Note: When you select AV Fistula or AV Graft for Type, a warning message displays 
to advise against using the patient’s affected arm for BP or needle sticks.  
You must place an arm band on the affected limb to prevent any mishaps. 

 

Warning: Place arm band.  
No blood pressure or  needle sticks in the arm that the AV Fistula or  AV Graft is in! 

5. To cancel entered data before upload, click Cancel edit. 
6. To upload updated information, click OK. 
7. To add another dialysis access location, repeat steps 2 through 6. 
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General Observations/Comments – IV Comments 

1. Click IV Comments. 
IV Comments displays. 

2. Populate IV Comments. 
Use the General observations/comments text box for additional information. 

 

RN Reassessment, IV (IV) tab, IV Comments window 
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Care Plan - IV CP 

1. Click IV CP. 
IV CP displays. 

2. Update IV CP.  
3. Add/update a problem evaluation and/or intervention status, if necessary. 

Refer to the instructions in Working in a Care Plan on page 12. 

 

RN Reassessment, IV – Problems/Interventions/Desired Outcomes (IV) tab, IV CP window 
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Respiratory (Resp)  
In the Respiratory tab, update or add breathing information to reflect the condition of the patient during a 
current reassessment. 
 
Responses from the previous assessment/reassessment are hard-coded into the reassessment, but the 
information is not transferred into the Progress Note of the current assessment.  

 

RN Reassessment, Respiratory Assessment (Resp) tab, Resp Page 1 window 

1. Click Resp.  
Resp Page 1 displays. 

2. Populate Resp Page 1. 
a. Use the Respiratory rate box to enter the patient’s current respiratory rate. 
b. Complete all the fields with asterisks; they are required fields. 
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3. Click Resp Page 2. 
Resp Page 2 displays. 

 

RN Reassessment, Respiratory Assessment (Resp) tab, Resp Page 2 window 

 

RN Reassessment, Respiratory Assessment (Resp) tab, Resp Page 2 window 
Chest tube locations 1 and 2 
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4. Populate Resp Page 2. 
Complete all the fields with asterisks; they are required fields. 
a. If the Respiratory Consult is set up at your site, use the Respiratory Consult button to order the 

consult, in accordance to the condition of the patient and the policy of your medical center. 
b. Refer to the instructions in Working in the Consults on page 24. 
c. Select the Other chest tube locations check box. 

The Other CT Loc page is made available. 
5. Click Other CT Loc. 

Other CT Loc displays. 
6. Populate Other CT Loc, CT locations 3 and 4, if necessary. 

Complete all the fields with asterisks; they are required fields. 

 

RN Reassessment, Respiratory Assessment (Resp) tab, Other  CT Loc window 
Other  CT locations, Location 3 and Location 4 

7. Click Resp Page 3. 
Resp Page 3 displays. 
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RN Reassessment, Respiratory Assessment (Resp) tab, Resp Page 3 window 
contains the Tobacco screen 

8. Populate Resp Page 3, if necessary.  
Complete all the fields with asterisks; they are required fields. 

9. Click Resp CP. 
Resp CP displays. 
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RN Reassessment, Respiratory – Problems/Interventions/Desired Outcomes (Resp) tab,  
Resp CP window 

10. Update Resp CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Cardiovascular (CV) 
Document the cardiovascular reassessment of a patient in the Cardiovascular tab. 

 

RN Reassessment, Cardiovascular  Assessment (CV) tab, CV Page 1 window 

1. Click CV. 
CV Page 1 displays. 

2. Populate CV Page 1. 
a. Complete all the fields with asterisks; they are required fields. 
b. Use the Extremities comments text box for additional information, if necessary. 

3. Click CV Page 2.  
CV Page 2 displays. 
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RN Reassessment, Cardiovascular  Assessment (CV) tab, CV Page 2 window 
Cardiac monitor  selected 

4. Populate CV Page 2. 
a. Complete all the fields with asterisks; they are required fields. 
b. Use the General observations/comments text box for additional information. 

5. Click CV CP.  
CV CP displays. 
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RN Reassessment, Cardiovascular  – Problems/Interventions/Desired Outcomes (CV) tab,  
CV CP window 

6. Update the CV CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Neurology (Neuro) 
Document the neurology reassessment of a patient in the Neurology tab. 

 

RN Reassessment, Neurological Assessment (Neuro) tab, Neuro Page 1 window 

1. Click Neuro. 
Neuro Page 1 displays. 

2. Populate Neuro Page 1. 
Complete all the fields with asterisks; they are required fields. 

3. Click Neuro Page 2. 
Neuro Page 2 displays.  
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RN Reassessment, Neurological Assessment (Neuro) tab, Neuro Page 2 window 

4. Populate Neuro Page 2. 
a. Complete all the fields with asterisks; they are required fields 
b. Use the General observations/comments text box for additional information. 

5. Click Neuro CP. 
Neuro CP displays. 
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RN Reassessment, Neurological – Problems/Interventions/Desired Outcomes (Neuro) tab, 
Neuro CP window 

6. Update Neuro CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Gastrointestinal (GI) 
Document the gastrointestinal reassessment of a patient in the Gastrointestinal tab. 

 

RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Page 1 window 

1. Click GI. 
GI Page 1 displays. 

2. Populate GI Page 1. 
Complete all the fields with asterisks; they are required fields. 

3. Click GI Dev. 
GI Page Dev displays. 
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RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Dev window 
GI Devices #1-#4 

• If there are no previous devices, the fields are void.  
• If the patient has a device at the time of the previous assessment, it displays in GI Device #1. 

 

RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Dev window, 
GI Device #1 

4. Populate GI Dev.  
Complete all the fields with asterisks; they are required fields. 

5. Click GI Dev 2.  
GI Dev 2 displays. 
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RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Dev 2 window 
GI Devices #5-#8 

6. Populate GI Dev 2, if necessary. 
Complete all the fields with asterisks; they are required fields. 

7. Click GI Page 2.  
GI Page 2 displays. 
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RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Page 2 window 

8. Populate GI Page 2. 
a. Complete all the fields with asterisks; they are required fields. 
b. GI Page 2 contains the Nutrition Consult. 

Refer to the instructions in Working in the Consults on page 24. 
9. Click GI Page 3. 

GI Page 3 displays. 
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RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Page 3 window 

10. Populate GI Page 3.  
a. Complete all the fields with asterisks; they are required fields. 
b. Use the General observations/comments text box for additional information. 
c. GI Page 3 contains the Speech Consult. 

Refer to the instructions in Working in the Consults on page 24. 
11. Click GI CP. 

GI CP displays. 
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RN Reassessment, Gastrointestinal – Problems/Interventions/Desired Outcomes (GI) tab,  
GI CP window 

12. Update the GI CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Genitourinary (GU) 
Document the genitourinary reassessment of a patient in the Genitourinary tab. If a patient has a GU 
device documented in a previous assessment, the device displays in the current reassessment.  

 

RN Reassessment, Genitour inary Assessment (GU) tab, GU Page 1 window 

1. Click GU.  
GU Page 1 displays. 

2. Populate GU Page 1.  
Complete all the fields with asterisks; they are required fields. 

3. Click GU Dev. 
GU Dev displays.  

  



 

76 Patient Assessment (NUPA) V.1 April 2012 
 RN Reassessment User Manual 

4. Populate GU Dev. 
Complete all the fields with asterisks; they are required fields. 

 

RN Reassessment, Genitour inary Assessment (GU) tab, GU Dev window 

5. Click GU Page 2. 
GU Page 2 displays with the Indwelling Catheter field unavailable because there is no history of an 
indwelling catheter. 
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RN Reassessment, Genitour inary Assessment (GU) tab, GU Page 2 window 
Female patient infor mation available 

 

RN Reassessment, Genitour inary Assessment (GU) tab, GU Page 2 window 
Male patient infor mation available 
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Note: The sex-specific questions (male/female) are optional. The exception is for female 
patients; the pregnancy responses are required. 

6. Populate GU Page 2.  
a. Complete all the fields with asterisks; they are required fields. 
b. Use the General observations/comments text box for additional information. 

Indwelling Catheter 

If the presence of an indwelling catheter is documented, the size of the indwelling catheter is 
available when this data is not entered in a field that is pulled forward.  
 
The size of the catheter can be entered in a previous reassessment on the GU Dev page in the General 
observations/comments text box. 

 

RN Reassessment, Genitour inary Assessment (GU) tab, GU Page 2 window 

This data is pulled forward to the next reassessment template when entered in an admission 
assessment or a previous reassessment. 
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7. Click GU CP. 
GU CP displays. 

 

RN Reassessment, Genitour inary – Problems/Interventions/Desired Outcomes (GU) tab,  
GU CP window 

8. Update GU CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Musculoskeletal (M/S) 
Document the musculoskeletal reassessment of a patient in the Musculoskeletal tab. 
 
Directions for the Morse Fall Scale are on M/S Page 2. The directions are only on the template and are 
not transferred into the completed Progress Note. 
• The Total Morse score for fall risk for the patient is calculated automatically as you select responses 

for history of falling, secondary diagnosis, ambulatory aid, gait/transferring, and marital status. 
• The Morse Score is pulled forward to the M/S CP page to guide the entry of interventions. 
 
1. Click M/S. 

M/S Page 1 displays.  

 

RN Reassessment, Musculoskeletal Assessment (M/S) tab, M/S Page 1 window 

2. Populate M/S Page 1.  
a. Complete all the fields with asterisks; they are required fields. 
b. Use the General observations/comments text box for additional information. 
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3. Click M/S Page 2.  
M/S Page 2 displays. 

 

RN Reassessment, Musculoskeletal Assessment (M/S) tab, M/S Page 2 window 

4. Populate M/S Page 2. 
Complete all the fields with asterisks; they are required fields. 
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5. Optional: To complete a Morse Scale, select Yes for Fall risk assessment indicated. 
If you select Yes, the fall risk assessment questions must be answered. 

 

RN Reassessment, Musculoskeletal Assessment (M/S) tab, M/S Page 2 window 
Morse Fall Scale 

6. Click M/S CP.  
M/S CP displays. 
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RN Reassessment, Musculoskeletal – Problems/Interventions/Desired Outcomes (M/S) tab,  
M/S CP window 

7. Update M/S CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 

Note: Universal Fall Precautions must be completed for all patients. 
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Skin (Skin) 
Document the skin reassessment of a patient in the Skin tab. If a patient has pressure ulcers and skin 
alterations documented in a previous assessment, the information displays in the current reassessment. 
 
Directions for the Braden Scale for Predicting Pressure Sore Risk are on Skin Page 3. 
• The Total Score for the patient is calculated automatically as you select scores (1-4) for sensory 

perception, moisture, activity, mobility, nutrition, and friction and shear.  
• The Braden Score is pulled forward to the Skin CP page to guide the entry of interventions. 
 
Skin CP contains patient/caregiver skin care education, including risk for skin breakdown and 
prevention/treatment of problems related to skin integrity. 

 

RN Reassessment, Skin Assessment (Skin) tab, Skin Page 1 window 

1. Click Skin.  
Skin Page 1 displays. 

2. Populate Skin Page 1 
a. Complete all the fields with asterisks; they are required fields. 
b. Use the General observations/comments text box for additional information. 
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Documenting Pressure Ulcers 

From the Skin Page 1 tab, select Pressure ulcers and the Skin Pr Ul 1 tab becomes available. 

 

RN Reassessment, Skin Assessment (Skin) tab, Skin Page 1 window 
Pressure ulcer s selected 

1. Click Skin Pr Ul 1. 
Skin Pr Ul 1 displays. 

2. Populate Skin Pr Ul 1. 
a. Enter Location, Stage, and Status for up to six pressure ulcer locations. 

The fields with asterisks are required fields. 
b. Enter a Description of ulcer/dressing, if appropriate. 

 

RN Reassessment, Skin Assessment (Skin) tab, Skin Pr  Ul 1 window 
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Pressure Ulcer Drop-downs 

 

Skin Assessment - Pressure Ulcer /Location 

 

Skin Assessment - Pressure Ulcer /Stage 

 

Skin Assessment - Pressure Ulcer /Status 

3. To enter more than six pressure ulcer locations, select the Other pressure ulcer locations? check 
box. 
Skin Pr Ul 2 displays. 

 

RN Reassessment, Skin Assessment (Skin) tab, Skin Pr  Ul 1 window 
Other  pressure ulcer  locations? selected 
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RN Reassessment, Skin Assessment (Skin) tab, Skin Pr  Ul 2 window 

4. Populate Skin Pr Ul 2. 
a. Enter Location, Stage, and Status for six additional pressure ulcer locations. 

The fields with asterisks are required fields. 
b. Enter a Description of ulcer/dressing, if appropriate. 
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Documenting Skin Alterations 

From the Skin Page 1 tab, select Skin alterations and the Skin Alt 1 tab becomes available. 

 

RN Reassessment, Skin Assessment (Skin) tab, Skin Page 1 window 
Skin alterations selected 

1. Click Skin Alt 1. 
Skin Alt 1 displays. 

 

RN Reassessment, Skin Assessment (Skin) tab, Skin Alt 1 window 
Skin Alterations #1-#6 

2. Populate Skin Alt 1. 
a. Enter Type, Location, and Size for up to six (#1-#6) skin alterations. 

The fields with asterisks are required fields. 
b. Enter a Description for skin alteration, if appropriate. 
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Skin Alteration Drop-downs 

 

Skin Assessment – Skin Alteration/Type 

 

Skin Assessment – Skin Alteration/Location 

 

Skin Assessment – Skin Alteration/Size 
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3. Click Skin Alt 2. 
Skin Alt 2 displays. 

 

RN Reassessment, Skin Assessment (Skin) tab, Skin Alt 2 window 
Skin Alterations #7-#12 

4. Populate Skin Alt 2. 
a. Enter Type, Location, and Size for six (#7-#12) additional skin alterations. 

The fields with asterisks are required fields. 
b. Enter a Description of skin alteration, if appropriate. 

5. Click Skin Page 3. 
Skin Page 3 displays. 
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RN Reassessment, Skin Assessment (Skin) tab, Skin Page 3 window 
Braden Score for  Predicting Pressure Sore Risk 

Note: Braden Scale for Predicting Pressure Sore Risk is optional in the reassessment.  

6. Populate Skin Page 3. 
a. Select Yes to Skin assessment indicated, to complete the Braden Scale for Predicting Pressure 

Sore Risk. 
Complete all the fields with asterisks; they are required fields. 

b. Select No to Skin assessment indicated, to bypass the Braden Scale for Predicting Pressure 
Sore Risk. 
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RN Reassessment, Skin Assessment (Skin) tab, Skin Page 3 window 
Braden Score for  Predicting Pressure Sore Risk 

Skin assessment indicated selected 

c. Optional: Order a Nutrition Consult and/or Wound Care Consult from Skin Page 3, if necessary. 
Refer to the instructions in Working in the Consults on page 24. 

7. Click Skin CP.  
Skin CP displays. 
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RN Reassessment, Skin – Problems/Interventions/Desired Outcomes (Skin) tab,  
Skin CP window 

8. Update Skin CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Psychosocial (P/S) 
Document the psychosocial reassessment of a patient in the Psychosocial tab. This includes 
documentation for patients in restraints. 
 
Directions for the Clinical Institute Withdrawal Assessment (CIWA) are on the CIWA page.  
• The CIWA Score for the patient is calculated automatically as you select a response level for 

nausea/vomiting, tremor, paroxysmal sweats, anxiety, agitation, tactile disturbances, auditory 
disturbances, visual disturbances, headache, and orientation/clouding of sensorium. 

• The CIWA Score is pulled forward to the P/S CP page to guide the entry of interventions. 
 
1. Click P/S.  

P/S Page 1 displays. 

 

RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 1 window 

2. Populate P/S Page 1. 
a. There are no required fields on P/S Page 1. 
b. If the patient answers Yes to any of the abuse questions, a Social Work Consult is required.  

Refer to the instructions in Working in the Consults on page 24. 
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RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 1 window, Required 
Social Work Consult 

Note: For emphasis, the notify provider, send consult, and follow your state’s reporting 
regulations are highlighted in red. 

3. Click P/S Page 2. 
P/S Page 2 displays (Optional Suicide Risk - Ask Patient). 

 

RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 2 window 

4. Populate P/S Page 2. 
a. The questions on P/S Page 2 are optional. 
b. If a patient answers Yes to Have you recently had thoughts about harming yourself, you must 

Notify provider and Keep patient under close observation, according to medical center policy. 
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RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 2 window 

5. Click P/S Page 3.  
P/S Page 3 displays. 

 

RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 3 window 
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6. Populate P/S Page 3.  
a. The questions are all optional; update, if necessary. 
b. If a patient answers Yes to any of the Elopement Screen questions, a Social Work Consult is 

required. 
Refer to the instructions in Working in the Consults on page 24. 

 

RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 3 window, Social work 
consult mandatory 

c. P/S Page 3 contains the Alcohol use section. 

 

Alcohol use section 

7. If there is the possibility of alcohol withdrawal, select the Possibility of alcohol withdrawal check 
box to display the CIWA page. 
a. Complete all the CIWA fields with asterisks; they are required fields. 
b. Alert the physician of the possibility of alcohol withdrawal. 
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RN Reassessment, Psychosocial Assessment (P/S) tab, CIWA window 

8. Click P/S Page 4. 
P/S Page 4 displays.  

 

RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 4 window 
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9. Populate P/S Page 4. 
Use the General observations/comments text box for additional information. 

10. Click P/S CP. 
P/S CP displays. 

 

RN Reassessment, Psychosocial Assessment –Problems, Interventions, Desired Outcomes 
(P/S) tab, P/S CP window 

11. Update P/S CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Restraints (Rest/Restr) 
There are two categories of restraints. 
• Patient is pulling at lines/tubes used in their treatment or is unable to follow instructions, endangering 

their medical/surgical recovery. Patient is not violent or self-destructive 
• Patient’s behavior is aggressive or violent presenting an immediate, serious danger to his/her safety or 

that of others 

 

RN Reassessment, Restraints (Rest) tab, Restr  Page 1 window 

1. Click Rest.  
Restr Page 1 displays. 

2. Select the Restraints Initiated/maintained check box. 
The reasons for restraint become available. 
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RN Reassessment, Restraints (Rest) tab, Restr  Page 1 window 
with restraints initiated/maintained selected 
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a. When you select, Patient is pulling at lines/tubes …, the following window displays. 

 

RN Reassessment, Restraints (Rest) tab, Restr  Page 1 window 
Patient is pulling at lines/tubes used in their  treatment or  is unable to follow instructions  

endanger ing their  medical/surgical recovery. Patient is not violent or  self-destructive 
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b. When you select, Patient’s behavior is aggressive or violent …, the following window displays. 

 

RN Reassessment, Restraints (Rest) tab, Restr  Page 1 window 
Patient’s behavior  is aggressive or  violent  

presenting an immediate ser ious danger  to his/her  safety or  that of others 

3. Populate Restr Page 1.  
a. Select a Reason for restraint. 
b. Complete all the fields with asterisks; they are required fields. 

Questions are based on standards for documenting seclusion or restraint.  
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4. Click Restr CP. 
Restr CP displays. 

 

RN Reassessment, Restraints – Problems/Interventions/Desired Outcomes (Rest) tab,  
Restr  CP window 

5. Update Restr CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Mental Health (MH) 
The Mental Health tab is completed for patients admitted to acute psychiatry, or when any patient reports 
a new mental health problem.  

 

RN Reassessment, Mental Health Assessment (MH) tab, MH Page 1 window 

1. Click MH. 
MH Page 1 displays.  

2. Populate MH Page 1. 
Complete all the fields with asterisks; they are required fields. 

  



 

106 Patient Assessment (NUPA) V.1 April 2012 
 RN Reassessment User Manual 

3. Click MH Page 2. 
MH Page 2 displays. 

 

RN Reassessment, Mental Health Assessment (MH) tab, MH Page 2 window 

4. Populate MH Page 2. 
a. Complete all the fields with asterisks; they are required fields. 
b. Use the General observations/comments text box for additional information. 

5. Click MH CP. 
MH CP displays. 
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RN Reassessment, Mental Health Assessment (MH) tab, MH CP window 

6. Update MH CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12. 
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Functional (Func) 
Document the functional (bathing, dressing, toileting, transferring, continence, and feeding) reassessment 
of a patient in the Functional tab. 
 
Directions for the Katz Index of Independence in Activities of Daily Living are on Func Page 1. The Total 
Score for the patient is calculated automatically as you select Independence/Dependence for six activities. 

 

RN Reassessment, Functional Assessment (Func) tab, Func Page 1 window 

1. Click Func. 
Func Page 1 displays.  

2. Update Func Page 1, if necessary.  
The fields are optional. 

Note: Refer to provider for evaluation, if patient has a Katz score of 4 or less, or a 
decrease in the level of independence and changes have occurred within the past 
month. 
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3. Click Func Page 2.  
Func Page 2 displays. 
• If the patient is independent and cooperative, no additional entries are necessary on Func Page 2. 

 

RN Reassessment, Functional Assessment (Func) tab, Func Page 2 window 
when the patient is independent 
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• If the patient is dependent and completely uncooperative, additional entries are necessary on Func 
Page 2. 

 

 RN Reassessment, Functional Assessment (Func) tab, Func Page 2 window 
when the patient is dependent 

4. Update Func Page 2, if necessary. 
a. Complete all the fields with asterisks; they are required fields. 
b. Use the General observations/comments text box for additional information. 
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5. Click Func Page 3.  
Func Page 3 displays. 

 

RN Reassessment, Functional Assessment (Func) tab, Func Page 3 window 

6. Populate Func Page 3.  
a. Complete the fields, if necessary. 
b. Click Print. 
c. Print Func Page 3 and give it to the staff handling the move of the patient. 
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7. Click Func CP.  
Func CP page displays. 

 

RN Reassessment, Functional – Problems/Interventions/Desired Outcomes (Func) tab,  
Func CP window 

8. Update Func CP, if necessary. 
Refer to the instructions in Working in a Care Plan on page 12 . 
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Discharge Planning (DP) 
Document the discharge reassessment for a patient in the Discharge Planning tab. 

 

RN Reassessment, Discharge Planning (DP) tab, DP Page 1 window 

1. Click DP. 
DP Page 1 displays. 

2. Populate PD Page 1, if available. 
a. If a DP Page 1 was completed during the admission assessment, none of the fields are active. 
b. Use the General observations/comments for additional information. 

Note: The presence of the guardian and name of the legal guardian are pulled forward 
and can be edited on P/S Tab, Page 3. 
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3. Click DP CP. 
DP CP displays. 

 

RN Reassessment, Discharge Planning – Problems/Interventions/Desired Outcomes (DP) tab,  
DP CP window 

4. Populate DP CP.  
a. Complete the fields as necessary. 

Refer to the instructions in Working in a Care Plan on page 12. 
b. Complete a Social Work Consult or Discharge Planning Consult, if required. 

Refer to the instructions in Working in the Consults on page 24. 
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c. Optional: Complete a Telehealth Consult or a Home Care Consult, if set up by your medical 
center. 

Note: If an item in the Anticipated Discharge Plan Goals list box contains **, a Social 
Work Consult or Discharge Planning Consult is required. 

 

 
RN Reassessment, Discharge Planning – Problems/Interventions/Desired Outcomes (DP) tab,  

DP CP window, Consult Required 
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PCE Data (PCE) 
The PCE (Patient Care Encounter) Data tab is optional and may or may not be set up at your medical 
center. The PCE tab includes a list of all clinical reminders due for the patient, as well as specific nurse 
Clinical Reminders. 
 
Use the PCE tab to document specific clinical reminders completed by the inpatient nurse. 

Note: The clinical reminders must be set up by your facility. 

 

RN Reassessment, PCE Data (PCE) tab 

Reminders Due (Display Only) 

The list of all clinical reminders due for the patient is for display only. You cannot take action on the 
reminders from within the reassessment template. 
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Clinical Maintenance 

1. Select a clinical reminder in the Reminders Due list box. 
2. Click Clinical Maintenance. 

Information displays in the Maintenance Results list box indicating when the reminder is due or was 
last done. 

 

Clinical Maintenance 
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Reminder Inquiry 

Click Reminder Inquiry. 
Information displays in the Inquiry Results list box about the logic of the selected reminder. 

 

Reminder  Inquiry 
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Resolve Inpatient Nursing Clinical Reminders 

1. Select an item in the Inpatient Nursing PCE Information list box. 

 

Resolve Inpatient Nursing Clinical Reminders 

2. Click Resolve. 
The Resolve Reminder Pain Risk, Mgmt, and Assessment window displays with items appropriate for 
the selected item. 

 

Resolve Reminder  Pain Risk, Mgmt, and Assessment window 

3. Select an item from Received?  
4. Select an item from Level of Understanding. 
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5. Click Resolve. 
Information  displays indicating the reminder is resolved. 

 

Information : Reminder  resolved! 

6. Click OK. 
The text that is added to the Progress Note displays in the Text (will be added to note) text box. 

 

Text (will be added to note) 
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View Text (View Text) 
The View Text tab is a review of all the information added/updated for a patient during the reassessment. 

 

RN Reassessment, View Text tab 

1. Click View Text. 
The View Text window scrolls through the admission reassessment for review. 

2. Review the patient admission reassessment. 
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Signing Note and Consults from within the Template 

During the assessment, you may be prompted to enter mandatory consults that will be uploaded with the 
reassessment note. 

Note: Manage consults according to medical center policy. If nurses at your site do not 
order consults, upload a mandatory consult, but do not sign it.  
The identified provider will be notified that there is a consult to sign. 

Go to CPRS to sign your uploaded, unsigned notes and consults. 
 
You can also sign unsigned notes after the upload from the View Text tab in the template. 
 
1. Click View Text. 

 

RN Reassessments, View Text Tab after  Upload 

2. Click Sign Note/Consult. 
If the button does not display, upload again.  
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Note: If there is only a note to sign, the button is Note. 
If there is a consult to sign, the button is Sign Note/Consult. 

 

RN Reassessment, Sign Note/Consult Button 

3. Enter your electronic signature and click Accept e-sig. 
Information  displays, Note signed!. 

4. Click OK. 
5. To prevent the signing of an uploaded note, click Cancel e-sig. 

Note: It is safer to go to CPRS, read the note in CPRS, and sign the note in CPRS.  

• An unsigned note can be edited.  
• A signed note cannot be edited. 
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Unable to Complete the Assessment 
An incomplete admission assessment is filed when the nurse is unable to complete an assessment because 
the patient cannot respond to admission assessment questions and there is no caregiver available to 
provide the necessary data. The reassessment that opens after the assessment is signed, allows you to 
enter the missing data. 
 
1. Open RN Reassessment. 

Gen Inf tab, Gen I Page 1 displays, 
2. Select Yes or No for Patient/family/support person able to respond to questions. 

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 1 window 
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Patient still cannot respond 
1. If the patient still cannot respond, select No and select a reason(s) *Why could no one respond. 

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 1 window 
with *Why could no one respond 

2. Continue through the reassessment tabs and pages.  
3. Complete all the fields with asterisks; they are required fields. 
4. Upload the information. 
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The following screen captures are examples of the tabs when No is selected for Patient/family/support 
person able to respond to questions. 

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 2 window 

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 3 window 



 

April 2012 Patient Assessment (NUPA) V.1 127 
 RN Reassessment User Manual  

 

 

RN Reassessment, Educational Assessment (Educ) tab, Educ Page 1 window 

 

RN Reassessment, Pain Assessment (Pain) tab, Pain Page 1 window 
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RN Reassessment, IV (IV) tab, IV Per iph window 

  

RN Reassessment, Respiratory Assessment (Resp) tab, Resp Page 1 window 
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RN Reassessment, Respiratory Assessment (Resp) tab, Resp Page 2 window 

 

RN Reassessment, Respiratory Assessment (Resp) tab, Resp Page 3 window 
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RN Reassessment, Cardiovascular  Assessment (CV) tab, CV Page 1 window 

 

RN Reassessment, Cardiovascular  Assessment (CV) tab, CV Page 2 window 
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RN Reassessment, Neurological Assessment (Neuro) tab, Neuro Page 1 window 

 

RN Reassessment, Neurological Assessment (Neuro) tab, Neuro Page 2 window 
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RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Page 1 window 

 

RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Dev window 
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RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Page 2 window 

 

RN Reassessment, Gastrointestinal Assessment (GI) tab, GI Page 3 window 
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RN Reassessment, Genitour inary Assessment (GU) tab, GU Page 1 window 

 

RN Reassessment, Genitour inary Assessment (GU) tab, GU Dev window 
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RN Reassessment, Genitour inary Assessment (GU) tab, GU Page 2 window 

  

RN Reassessment, Musculoskeletal Assessment (M/S) tab, M/S Page 1 window 
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RN Reassessment, Musculoskeletal Assessment (M/S) tab, M/S Page 2 window 

  

RN Reassessment, Skin Assessment (Skin) tab, Skin Page 1 window 
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RN Reassessment, Skin Assessment (Skin) tab, Skin Page 3 window 

  

RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 1 window 
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RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 2 window 

 

RN Reassessment, Psychosocial Assessment (P/S) tab, P/S Page 3 window 
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RN Reassessment, Restraints (Rest) tab, Restr  Page 1 window 

  

RN Reassessment, Mental Health Assessment (MH) tab, MH Page 1 window 
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RN Reassessment, Functional Assessment (Func) tab, Func Page 1 window 

 

RN Reassessment, Functional Assessment (Func) tab, Func Page 2 window 
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RN Reassessment, Functional Assessment (Func) tab, Func Page 3 window 

  

RN Reassessment, Discharge Planning (DP) tab, DP Page 1 window 
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RN Reassessment, Discharge Planning (DP) tab, DP CP window 
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Patient can respond 
1. If the patient can respond, select Yes and select where the *Information obtained from.  

 

RN Reassessment, General Information (Gen Inf) tab, Gen I Page 1 window  

2. Continue through the reassessment tabs and pages.  
3. Complete all the fields with asterisks; they are required fields.  

Note: For the content of the template, refer to the User Manual for Admission – RN 
Assessment. 

4. Upload the information. 
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Updating the Reassessment Note 
PADP provides you with the ability to document simple updates during a tour of duty. You do not have to 
re-enter a completed reassessment every time you document. For another tour of duty, just return to the 
reassessment template and update information.  
 
1. In CPRS, open the Tools menu and select RN Reassessment. 

RN Reassessment opens to the CPRS patient. 
2. If the patient had a reassessment completed within the last 24 hours, the following screen displays 

providing several choices for initial reassessment for shift and update reassessment (full 
reassessment completed previously on current shift). 

 

RN Reassessment window 
with Assessment Types 

Note: The template that opens is identical to the initial RN Reassessment with one 
exception-there are no required fields. 

3. Move to the tab that requires updating. 
For example, to document that an IV was discontinued: 
a. Click IV. 
b. Select an IV to discontinue.  
c. Select the IV discontinued check box. 

4. Open the File menu and select Upload Data. 
Data is uploaded. 

5. Sign note in CPRS or from the View Text tab. 
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Glossary 
Term Definition 

ADPAC Automated Data Processing Application Coordinator 
ART Adverse Reactions Tracking 
BCE Bar Code Expansion 
BCE-PPI Bar Code Expansion-Positive Patient Identification 
BCMA Bar Code Medication Administration 
Belong Belongings 
CAC Clinical Application Coordinator 
CIWA Clinical Institute Withdrawal Assessment.--CIWA 
Class 1 (C1) Software produced inside of the Office of Enterprise Development (PD) 

organization 
Class 3 (C3) Also known as Field Developed Software  

Refers to all VHA software produced outside of the Office of Enterprise 
Development (PD) organization 

CMS Centers for Medicaid and Medicare Services 
COTS Commercial Off the Shelf 
CP Care Plan 
CPRS Computerized Patient Record System 
CV Cardiovascular Assessment 
Delphi Programming language used to develop the CPRS chart 
DFN Data File Number 
DP Discharge Planning 
Educ Educational Assessment  
Func Functional Assessment 
Gen Inf General Information tab 
GI Gastrointestinal Assessment 
GU Genitourinary Assessment 
GUI Graphical User Interface 
ICD International Classification of Diseases 

ICN The patient’s national identifier, Integration Control Number  

IDPA Interdisciplinary Patient Assessment - involves multiple disciplines responsible 
for assessing the patient from their perspective and expertise. 

IDPC Interdisciplinary Plan of Care -  The entry of treatment plans by multiple 
disciplines to meet JCAHO requirements 

IV Intravenous 

IV Central Central IV lines 



 

146 Patient Assessment (NUPA) V.1 April 2012 
 RN Reassessment User Manual 

Term Definition 

IV Dialysis IV Dialysis ports 

IV Periph IV Peripheral lines 
JCAHO Joint Commission on Accreditation of Healthcare Organizations  
LPN Licensed Practical Nurse 
M/S Musculoskeletal Assessment 
MAS Medical Administration Service 
MH Mental Health Assessment 
MRSA Methicillin-Resistant Staphylococcus Aureus 
NAA Nursing Admission Assessment  
Neuro Neurological Assessment 
NHIA Nursing Healthcare Informatics Alliance 
NPAT National Patient Assessment Templates 
NUPA Namespace assigned to  the Patient Assessment Documentation Package 

(PADP) by Database Administrator 
OED Office of Enterprise Development 
OERR Order Entry Results Reporting 
OIT Office of Information and Technology 
ONS Office of Nursing Services 
Orient Orientation to Unit 
P/S Psychosocial Assessment 
PADP Patient Assessment Documentation Package  
Pain  Pain Assessment 
PC Plan of Care 
PCE Patient Care Encounter 
PD Product Development 
PHR Patient Health Record 
Prob Problems/Interventions/Desired Outcomes tab in the RN Reassessment 
Resp Respiratory Assessment 
Rest (or Restr) Restraints 
RN Registered Nurse 
RPC Remote Procedure Call 
RSD Requirements Specification Document 
Section 508 Under Section 508 of the Rehabilitation Act, as amended (29 U.S.C. 794d) 

Public Law 106-246 (http://va.gov/accessible) agencies must provide employees 
and members of the public who have disabilities access to electronic and 
information technology that is comparable to the access available to employees 
and members of the public who are not individuals with disabilities 

Skin Skin Assessment 
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Term Definition 

SNOMED – CT Systemized Nomenclature of Medicine Clinical Terms 
TIU Text Integration Utilities Program 

All text in CPRS is stored in TIU 
TJC The Joint Commission 
V/S Vital Signs 
VA Department of Veterans Affairs 
VAMC Department of Veterans Affairs Medical Center 
VANOD VA Nursing Outcomes Database 
VHA Veterans Health Administration 
VistA Veterans Health Information Systems and Technology Architecture 

An enterprise-wide information system built around an electronic health record 
used throughout the Department of Veterans Affairs medical system. 

Vital Qualifiers Provide detail in to the unit of measurement used with the vital signs.   
Height in inches or centimeters?   
Weight in pounds or kilograms? 

 
For additional PADP information, refer to the user manuals for Admission – RN Assessment, Admission – 
Nursing Data Collection, and Interdisciplinary Plan of Care. 
 

Documentation for NUPA Version 1.0 is also available on 

• VA Software Documentation Library in the Clinical Section  
http://www4.va.gov/vdl/ 

• PADP SharePoint for NUPA Version 1.0 
http://vaww.oed.portal.va.gov/programs/class3_to_class1/padp/field_development 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

http://www4.va.gov/vdl/�
http://vaww.oed.portal.va.gov/programs/class3_to_class1/padp/field_development�
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Appendix A 
Reassessment Contingency Note 

Reassessment 
Contingency Note.pdf 
 
During system downtimes, print a copy of the attached Reassessment Contingency Note and use it to 
perform an RN Reassessment. 


	Introduction
	Using the RN Reassessment
	Opening RN Reassessment
	No Previously Saved Information
	Previously Entered Information Available for One Patient
	Restore Patient’s Data/No
	Restore Patient’s Data/Yes

	Previously Entered Information Available for Two or More Patients
	View the Patients?/No
	View the Patients?/Yes
	Patient on the List
	Patient not on the List


	Patient not yet Assigned to an Inpatient Bed

	Saving and Uploading Data
	Auto Save
	Manual Save
	Upload Data
	Save and Exit
	Save Now
	Exit
	Signing Notes

	Working in a Care Plan
	Care Plan Table
	Updating an Existing Problem/Intervention
	Adding a New Intervention for an Existing Problem
	Adding a New Problem/Intervention
	Other Problems
	Other Interventions

	Working in the Consults
	Working in the Template
	Moving through the Template with a Mouse
	Moving through the Template without a Mouse
	Ctrl-Alt Keys
	Go to Radiogroup

	Viewing Previously Entered Data


	Navigating the RN Reassessment Tabs
	General Information (Gen Inf)
	Adding an Allergy
	Initiating a Social Work Consult for Advance Directives
	Changing Emergency Contact Information

	Education (Educ)
	Pain (Pain)
	IV (IV)
	No IV/Vascular Access Devices
	Peripheral Lines - IV Periph
	Existing IV Lines
	New IV Lines

	Central IV Lines – IV Central
	Dialysis Ports - IV Dialysis
	General Observations/Comments – IV Comments
	Care Plan - IV CP

	Respiratory (Resp)
	Cardiovascular (CV)
	Neurology (Neuro)
	Gastrointestinal (GI)
	Genitourinary (GU)
	Indwelling Catheter

	Musculoskeletal (M/S)
	Skin (Skin)
	Documenting Pressure Ulcers
	Pressure Ulcer Drop-downs
	Documenting Skin Alterations
	Skin Alteration Drop-downs

	Psychosocial (P/S)
	Restraints (Rest/Restr)
	Mental Health (MH)
	Functional (Func)
	Discharge Planning (DP)
	PCE Data (PCE)
	Reminders Due (Display Only)
	Clinical Maintenance
	Reminder Inquiry
	Resolve Inpatient Nursing Clinical Reminders

	View Text (View Text)
	Signing Note and Consults from within the Template


	Unable to Complete the Assessment
	Patient still cannot respond
	Patient can respond

	Updating the Reassessment Note
	Glossary
	Appendix A Reassessment Contingency Note

